Using the Mindjet Platform and Templates for Marketing Launch Plans

Marketing organizations work in increasingly dynamic environments that demand them to be more agile, more responsive and more impactful. Marketing teams are being asked to work more effectively, and much faster than before. Without adequate tools to manage complex marketing projects – product launches, campaigns and events – marketing managers are at risk. Failed launches and campaigns, and non-performing events, cost the company money, and sometimes, they cost marketers their bonus, a promotion, or even their job.

Dispersed project teams can complicate matters further – how can the marketing manager coordinate tasks, and ensure deliverables are produced on time, with the players spread out across different locations and even different organizations? With Mindjet’s collaborative work management solutions, marketing managers can manage launches and campaigns from conception through development to execution, and improve communications across the entire team, wherever they are, ensuring success.

Learn how Mindjet software and custom templates enable your marketing organization to be more responsive and effective. This guide illustrates how your marketing team can use the launch planning template for more impactful product launches.

The capabilities shown in this guide are available with Mindjet software, which includes , Mindjet Web, Mindjet for Windows and Mac and Mindjet Mobile.

Overview of the Launch Planning Template

Let’s walk through an example that places you in the role of a marketing manager planning the launch of a new, international release, of an existing software product. This template is rich in that it allows for a tremendous amount of detail to be captured, but don’t worry – you can use just the parts you need, and customize it for your own launch.

As a marketing manager, you work in a distributed environment, and, as is typical with big launches, there are numerous deliverables to be produced to support the launch. Various specialists, such as writers and graphics designers, some of them off-site and employed by different agencies, will need access to the launch plan to track schedules and report progress.

This example assumes that you have chosen to use Mindjet to manage the launch, so that all your team members, wherever there are, can easily access the most up-to-date
Using the Mindjet Platform and Templates for Marketing Launch Plans

launch plan, online. Your team needs only to log into Mindjet Web to review and contribute to the launch plan, and they can do it with the web browser they already have installed on their computer.

Within the Tasks in Mindjet Web, you can lay out your launch plan, including dates, deadlines, actions and deliverables, and collaborate with your marketing team to define priorities and dependencies. Everyone can easily see a single, common version of the launch plan.

Once you’re ready to execute, use the Tasks tab in Mindjet Web and its social task management features to manage individual project tasks, see status updates and check-off action items. If you already have your launch plan finalized, you can skip directly to Action to start managing tasks.

Mindjet Mobile lets you manage the launch on the go, so you’re never out of touch.

Mindjet provides a complete solution to take your launch from vision to action. To follow the steps in this guide, simply download the template and sample map, and then upload them to your own Mindjet account.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Getting Started

Mindjet software enables marketing managers to capture, organize, plan and act on ideas and information in a visual environment that facilitates collaboration. Creating shared diagrams and visual plans improves communications, saves time, and helps everyone stay on schedule. Use Mindjet to deliver better results and provide greater transparency on marketing activities.

When the template is opened, it will look like this. Take a moment to review the ribbon and the top level map topics. You can also use the sample map as a reference, to see how the template may look, fully built-out.

The Market Information and Key Dates topics are designed to capture high-level perspectives of your launch plan.

The Actions / Deliverables topic is where you will drill down into all the details of your launch, and assign tasks to members of your marketing team, and outside agencies.

Reporting / Measurement is designed for tracking success indicators related to your launch, such as pre-orders, trial downloads, or user registrations. Lessons Learned is for post-launch analysis, to identify areas of improvement for future launches.

Of course, you are not limited to these topics – you can add new topics that meet your individual launch plan needs as you see fit.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Create a Subtopic

The first step is to plot the key dates for your launch, under the “Key Dates” top level topic.

Click on the “Key Dates” box, and then create a sub-topic either by clicking the New Subtopic button on the ribbon, or pressing the Insert key.

Repeat this step until you have entered all the key milestone dates for your launch.
Using the Mindjet Platform and Templates for Marketing Launch Plans

View in Context

After entering in your key milestone dates, your map should look something like this.

Mindjet allows you to see all your important dates in the context of the launch plan, and add further detailed information as sub-topics for each date. As you work on your plan, you and your team will save time as a result of having this high-level overview just a click away.

You can keep adding detail by adding more sub-topics, and then hide or reveal detail as you need to when reviewing or presenting the map.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Zero-in On the Right Information

Mindjet is powerful enough to allow you to track a substantial amount of detail about your product launch, yet flexible enough to let you display just the right level of detail, depending on your audience.

First, Mindjet lets you nest sub-topics several levels deep, to track all the details of your launch, but then you can collapse the map to hide all the detail to provide a higher level summary. Click on the + and – buttons on the map to expand or collapse branches.

Secondly, you can create separate branches in Mindjet that provide only an overview of your launch plan, like this Market Information branch that summarizes the key elements of your launch for stakeholders that don't need to see all the details.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Share and Collaborate

Now that you have created your map, you can share it with other members of your marketing team to communicate the schedule to them, and ask them to collaborate on the plan. When everyone has access to shared view of the plan, strategies, tasks and deadlines are clear, and the team operates more effectively.

Your map is stored as a file under the Files tab. Select the file, and then click Share in the ribbon.

Sharing Controls

When you share your map, you can give others full edit control, or restrict them to read only access.

If you’re actively collaborating with someone on the project, you’ll probably want to give them edit privileges. Stakeholders that just need to keep track of the project status can be given read-only privileges. An indicator in the lower right-hand corner of the map tells you how many people are currently editing the map.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Attach Data

Launch team members can add attachments and Internet links to the map. Attachments could be draft or final versions of marketing collateral pieces, messaging strategy documents, or a detailed milestone schedule. Attaching data to the map means no more lost time due to searching for key documents – everything is readily accessible from one application.

Select a sub-topic you wish to attach a document to, and then click the Attachment button in the ribbon. The dialog box will prompt you to select your attachment.

To add a link to a webpage, select a sub-topic, then, press the Hyperlink icon in the ribbon. Mindjet will display a small icon to the right of the sub-topic to indicate there is a hyperlink.
Web Services Integration

Useful information to support your launch can come from any number of places, including the Internet. With Mindjet, capturing and saving that information is a breeze.

For example, you may want to capture from LinkedIn the name of an important analyst you want to brief about your product launch. Click Add from Web from the Tools section of the ribbon to initiate a search for his or her name, and then capture that information in your map, attached to the appropriate sub-topic.
Prioritize

After you have identified the activities in your plan, you can work with your marketing team to prioritize the tasks and deliverables to make your launch a success. As you work through these exercises with your team, you will build tactical “muscle memory” in the organization, meaning that planning and execution will become more efficient with each successive launch or campaign.

Priorities are set via the Priority drop down in the Home tab of the ribbon. Select a sub-topic, and then click Priority, and choose the appropriate value.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Assign

As you develop your launch plan, you’ll want to assign activities to the marketing team members who will actually do the work, and record estimated time frames and deadlines for the work to be completed. You can then share the map to get buy-in from the marketing team on assignments and deadlines, and provide a clear, single-view of the project plan to all stakeholders. Mindjet improves communication across the team, and keeps everyone in synch.

To create and manage resources, select a sub-topic and then click the Resources icon under the Tasks section of the ribbon. To assign start dates and due dates, click the Task Info icon. Later, we’ll see how you can send these planning items to Tasks for execution and tracking using social task management.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Visualizing Relationships

With Mindjet, you can easily visualize dependencies or flow steps between related activities. This capability makes it easy for everyone to understand the necessary tasks and sequencing, eliminating confusion.

Click on the Relationship icon in the ribbon, then Insert Relationship to create an arrow from one sub-topic box to another, to graphically show the flow of activities.
Capture Notes and Minutes

Never misplace handwritten meeting notes again! With Mindjet, you can capture meeting minutes visually, by building out sub-topics identifying discussion items. Use Mindjet to capture in one place status updates, action items, and blocking issues across the marketing team, including team members at outside vendors such as creative agencies, public relations firms and design houses. When you bring external vendors into your Mindjet plan, you reduce the need for time-consuming meetings and keep people focused on producing their deliverables.

To capture typewritten notes, select a sub-topic box, then, click Notes in the Topic Elements section of the ribbon. When you share your map, everyone on the team will be able to see the points of discussion and action items, eliminating confusion.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Brainstorming

Instead of a whiteboard, use Mindjet’s visual canvas for brainstorming and capturing ideas. Everyone on the marketing team can simultaneously view and co-edit the map in Mindjet Web. You can share Mindjet’s canvas in real time with remote members of your marketing team, and save a copy for review later.

For example, suppose that you had an idea for a pre-release briefing event for a high-profile customer, and you wanted to brainstorm with your marketing team on ideas for the event. Mindjet lets you create floating topics on the canvas that you can use to quickly capture thoughts and ideas. After you’ve firmed up the details of your event, simply drag and drop the topic to attach it to the correct location in your map, and make it part of the formal plan.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Moving From Maps to Task

Once you have developed your plan, and shared your map with your team to confirm the dates and activities, it’s time to start executing against the plan, and producing the deliverables.

Let’s start with a draft copy of the product datasheet to support this launch. That action item is located in your map under the Collateral sub-topic in Product Marketing.

Select the Draft Copy sub-topic, and then click the Create icon in the Tasks section of the ribbon.

In the pop-up window, click the button for Selected Item, and assign it to My Task List. You’ll be able to re-assign the task to a different person and a specific project within Action. The action item, due dates, assignee and progress will all be managed under the Action tab.

After you have sent the item to Tasks, Mindjet will display a hyperlink icon next to the sub-topic, linking to the Action task.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Social Task Management

Your newly created task in Tasks will appear in your My Task list. Mindjet tracks due dates, progress, and assignees for individual tasks within a project.

You can also control who has visibility to the tasks, and see a full history of activities related to the task. Mindjet provides you with the tools and controls to track tasks as the work proceeds, and ensure that due dates are met, and deliverables are produced, helping to ensure a successful launch.

Within the Tasks module, you can build out your project and team members to it. Click the + button under the Projects section on the left side bar, and call the new project “Acme Software Launch.”

Click the + Members button to add team members to the project.

Managing Task Details

Now, you can click on the Draft Copy task in your active task list, re-assign it to another team member, and associate it with a project. Just click on the Assigned To and Project fields to select new assignees and the appropriate project to associate the task with. Use the free-form text comment field to add a note to the task, if necessary. Click the X in the top right hand corner to close the task.

Mindjet’s reporting capabilities let you easily determine which tasks have recently been completed, and which tasks are still outstanding. This gives you a clear view of the status of all your tasks, and lets you know where intervention is needed to keep your launch on track.
Using the Mindjet Platform and Templates for Marketing Launch Plans

Advanced Capabilities

So far, we’ve demonstrated the basics of how to use Mindjet Web to move from concept and planning (Maps) to execution, or Tasks. Mindjet for Desktop, either that be Windows or Mac offers additional advanced features that are useful for managing complex launches or campaigns, and for graphical analysis. Here are some examples.

Filter

Mindjet can track very complex projects with many deliverables and tasks, such as International launches that include language localization of marketing assets for different markets.

Using the Filter tool, you can clear away the clutter to focus only on priority one tasks to know which are the most important in the present moment. Save time by focusing only on the most pressing issues.

To start the filter, click on the funnel shaped icon in the Filter section of the ribbon, under the View tab. You can then select from different criteria to filter on, such as priority, progress or assigned owner.
Analyzing with Mindjet’s analysis view, it’s easy to create perceptual maps to visualize your product’s position in the marketplace relative to competitors.

This tool lets you easily create four-quadrant perceptual maps and customize the two labeled axes to your specific needs. The analysis is stored with the map and available for others to view when it’s shared.

Start by clicking New in the Analysis View section of the ribbon, under the View tab.

After the Analysis Window comes up, click Configure to Customize the axes, then click the + button to enter your product name and those of your competitors as topics.

Select all of the topics and click Move Topic into View to begin arranging the icons on the chart.

To re-use the chart as a template for future products, click Save as Analysis View Template.
Using the Mindjet Platform and Templates for Marketing Launch Plans
Conclusion

This guide has illustrated the power and flexibility of Mindjet for marketing activities, and demonstrated the core features you will use on a day to day basis. The more you use Mindjet, the more frequently you will find interesting ways to collaborate and increase your productivity.

You can use Mindjet not only for product launches, but also to plan and execute ongoing marketing campaigns, and to plan for events like trade show attendance and customer appreciate events. The more you use Mindjet, the more you'll find your imagination taking you in new directions.

Mindjet makes it easy to move from vision to action. Brainstorm and conceive your marketing ideas and plans with Mindjet's virtual canvas then lay out your plans in an easy-to-understand visual format. Then, translate those plans into execution with Mindjet’s social task management capabilities.

Increase your marketing team’s performance by re-using Mindjet maps from one campaign to the next, leveraging built-in “muscle memory” at the task and individual contributor level. Mindjet’s visual format and intuitive interface shorten the learning curve for new team members.

And not to worry, the Mindjet community and customer support team is just a click away when you have questions.

Please visit www.mindjet.com to find more advanced tutorials and other resources.